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1 The list of terms used

o

o

The Guide - this document: Auto-Intellect Software Package: Operator's Guide.

The system - the Auto-Intellect software system.

Server - computer with installed Auto-Intellect software package.

Traffic - the flow of vehicles.

Vehicle Tracer - the interface object designed for viewing the recognized LP numbers, the types and speeds of vehicles, as
well as for searching the LPR database and creating reports for specific time periods.

Traffic Monitor - the interface object designed for monitoring vehicle movement.

fps - frame frequency. Number of video stream frames processed by software per 1 second.

The list of terms used - 4
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2 Operator's Guide. Introduction
On page:

» The purpose and structure of the Guide
» The purpose of the Auto-Intellect system
« Recommendations for using the Auto-Intellect system

2.1 The purpose and structure of the Guide

The Guide is an informational reference designed for users of the Auto-Intellect system with Operator access rights responded for
operation with Auto-Intellect software and corresponding interface objects.

The Guide contains the following material:

1. General description of the Auto-Intellect software system.
2. How to use the Auto-Intellect software system.
3. Description of the user interface of the Auto-Intellect system.

2.2 The purpose of the Auto-Intellect system
The Auto-Intellect software system is designed for automated traffic monitoring and control, and has the following functionality:

1. License plate number recognition.
2. Centralized events registration and processing, generation of notifications and control commands according to flexible

algorithms.
Searching matches between the recognized plate number and the numbers in the database connected to Auto-Intellect.

Creating the photo and video archive.
Determining the overall traffic parameters and the parameters of individual vehicles.
Software scalability.

oukrWw

2.3 Recommendations for using the Auto-Intellect system
The Auto-Intellect software is installed as an extension to the Intellect software package.
For proper operation of the Auto-Intellect system, please follow these recommendations:

1. Follow the job description accurately.
2. Use the system for the intended purpose only.
3. Do not use the computer with /ntellectinstalled, to run other software which is not part of the /ntellect package.

Operator's Guide. Introduction - 5
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3 Using the Auto-Intellect software system

3.1 Starting and closing the system

Please check the working condition of all hardware components - connections, cameras, etc - prior to starting the system.

‘) Intellect

Shutdomn

The system can be started using one of the following methods:

1. Automatically. The system starts automatically after the operating system boots up.
2. Manually. To start the system manually, in the Start menu, select Programs -> Intellect -> Client Workstation, or use the
corresponding shortcut on the Desktop.

Access to the system can be protected by a password. In this case, enter your password to start the system.
To shut down the system, do the following:

1. Point the mouse to the upper right corner of the screen, the main control panel will open.

2. Click the E icon on the panel.
3. Select Shutdown in the menu that opens.

The shut down process will start, the password will be required if set.

Using the Auto-Intellect software system - 6
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(2 Intellect

Note.

The system can be set up to forbid the shut down. Then, the Shutdown item is not present in the menu.

3.2 Using the Traffic Monitor interface object

3.2.1 Displaying the current traffic information in table form
The table with current traffic parameters is shown in the Table sub-tab of the Current value tab.

Displaying the current traffic parameters by lane in a table.

Using the Auto-Intellect software system - 7
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Displaying the current traffic parameters by direction in a table.

Using the Auto-Intellect software system - 8
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The system can be set up to display the traffic parameters by lane or by traffic movement direction. In case of the by-lane display,
the columns correspond to traffic lanes, and rows correspond to traffic parameters. In case of the by-direction display, the
columns correspond to traffic directions, and rows correspond to traffic parameters.

Note.

The Time of registration parameter for each lane corresponds to the time when the last vehicle passed. The Time of
registration minus the Statistics update period is taken as the beginning of the period to base the statistics on, while
the current moment is taken for the end of the statistics period.

3.2.2 Displaying the current traffic information in graphic form
The charts with current traffic parameters are displayed in the Charts sub-tab of the Current value tab.

Displaying the charts of current traffic parameters by lane.

Using the Auto-Intellect software system - 9
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Displaying the charts of current traffic parameters by direction.
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Current Value ' Statistics Lraffic monitor 1
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The system can be set up to display the traffic parameters by lane or by traffic movement direction.

The Charts tab consists of several sections corresponding to the lanes or the traffic movement directions. Each section consists
of several subsections displaying some particular sets of traffic parameters in graphic form.

3.2.3 Creating a request for traffic statistics

To create a request for traffic statistics, use the Statistics tab.

' tatistiE‘D

3 4
BE End:| EHED C_Flefresh_) | Save e

Statistics per day || Statistics per week | Statistics per month | Selective statistics 2

Current value

Etections Total n... | Averag... | Violatio... Speedi...|h’|uving...| Total v...|.ﬁ.verag...|Traffic [

= Traffic Detection 1 =0 ] =0 0 =0 =0 0 Z0
B Movement towards camera =0 ] =0 =0 =0 =0 1] =0
B Lare 1 =0 ] =0 =0 =0 =0 0 =0

- Pazzenger cars I} ] 1] I} ] ] 1] I}

Trucks lezs than 11 m long ] ] 1] I} ] ] 1] I}

- Truckz from 11 to1dmlong 0O ] 1] N ] ] 1] 1]

Trucks more than 14 mlong 0 ] 1] I} ] ] 1] 0

- Buges 0 i 0 0 N 0 0 0
- Lane 2 =0 ] =0 Z0 =0 =0 0 0
- Lahe 3 =0 ] =0 =0 =0 =0 0 =0
B Lane 4 =0 ] =0 =0 =0 =0 0 =0

\. y,
m Charts /

Feady

To create a request for traffic statistics, do the following:
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1. Select the preferred type of statistics presentation by clicking the Table or the Charts tab.

Select the sampling period - Day, Week, Month, or Specific time period (specify the period manually).

3. If Specific time period is chosen, enter the beginning and the end date/time of the statistics period in the Beginning and
the End fields.

4. Click the Refresh button to create or update the statistics.

N

3.2.4 Displaying traffic statistics in table form

The traffic statistics in table form are displayed in the Table sub-tab of the Statistics tab.

/" Curert value@t_atistiﬁb
Beginr.. | BEl  End BEl C Refiesh Y | Savess..
| Statistics per week | Statistics per month | Selective statistics
etections | Total n... |.-'1‘-.verag...|"v"i|:||ati|:|...| Speedi... | Mu:uving...| Tatal v...|.-'1‘-.verag... | Traffic |
B Traffic Detection 1 =0 ] =0 =0 =0 =Z0 0 Z0
Bl Movement towards camera =0 ] = 0 =0 =0 = 0 1] =0
B Lare 1 =0 ] =0 =0 =0 =0 0 =0
Pazzenger cars ] ] 1] I} ] ] 1] 0
- Trucks lezs than 11 m long ] ] 1] I} ] ] 1] 0
Truckz fram 11t ldmlong 0O ] 1] I} ] ] 1] 0
- Trucks more than 14 mlong 0O ] 1] N ] ] 1] ]
- Buses 0 0 0 0 0 0 0 0
- Lane 2 =0 ] =0 Z0 =0 =z 0 0 Z0
- Lane 3 =0 ] =0 =0 =0 Z0 0 =0
- Lane 4 =0 ] =0 =0 =0 =0 0 =0
\. J/
Table & Charts /
Feady

The traffic statistics are displayed in the following tree structure: Recognizer name -> Movement direction -> Lane -> Vehicle
type. The statistics data for each level of the tree is shown.

Note.
To refresh the displayed statistics, click the Refresh button.

3.2.5 Displaying traffic statistics in graphic form
The traffic statistics in graphic form are displayed in the Charts sub-tab of the Statistics tab.
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Current Value |/ Statistics ) Iraffic monitor 1
Beginni...||24.03.2009 0:00:00 Refresh | Save as... I
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Time Time
Incidents detected | X
1| 3
Table 4 Charts
Ready [ e
Note.

To refresh the displayed statistics, click the Refresh button.

3.2.6 Saving traffic statistics to a file

The Statistics tab allows saving the traffic statistics into a file.
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/ Curment value € gtatistiﬁb
{Beginr..| BEl  End| BEE  Refesh | Saveds. )

Statistics per day || Statistics per week | Statistics per month | Selective statistics

Detectionz | Total ... |.-’-'-.verag...|‘»-’iu::|atiu::...| Speedi.. | Mu:u\fing...| Tatal v...|.-’-‘-.verag... | Traffic: ||
= Traffic Detection 1 =0 ] =z 0 =0 =0 =0 0 =z 0
Bl Movement bowards camera =0 ] =0 =0 = =0 1] =0
B Lane 1 =0 ] =0 =0 =0 =0 0 =0
Pazzenager cars ] ] 1] I} ] ] 1] I}
- Trucksz lezs than 11 m lang ] ] 1] ] ] ] 1] ]
Trucks from 11 @14 mlong 0O ] 1] I} ] ] 1] I}
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- Buses 0 0 0 0 0 0 0 0
B Lane 2 =0 ] =0 =0 =0 =0 0 =0
- Lane 3 =0 ] =0 =0 =0 =0 0 =0
- Lane 4 =0 ] =0 Z0 =0 =0 0 E0

Table # Charts /

Ready

To export the traffic statistics into a file, do the following:

1. Create and display the request for traffic statistics (see the Creating a request for traffic statistics section).
2. Click the Save as button.

3. Enter the pathname in the window that opens and click Save.

4. The traffic statistics will be saved in the specified location in a CSV file.

3.3 Using the Vehicle Tracer interface object

3.3.1 Introduction

The Vehicle Tracer interface object includes the following components:

1. On-line monitor - is designed for displaying the data about identified plates and for handling alarms;

2. Events monitor -displays video frame with a vehicle, which plate is being recognized at the moment and also identified
number and speed.

3. Alarm window - is designed for displaying the data about vehicles in case of coincidence of recognized plates with plates
which are stored on the external orientation database.

Note.

Events monitor and Alarm window components are optional and aren't displayed with corresponding system settings
(see the document Auto-Intellect software package: Administrator guide).

3.3.2 Viewing the data about passing vehicle

The passing vehicle data is displayed in the Events monitor window.

Using the Auto-Intellect software system - 14
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LPR. channel 1

Note

Events monitor component may not be displayed due to the corresponding system settings (see Auto-Intellect
software package: Administrator's guide).

In the Events monitor window, the following data is displayed:

1. LPrecognizer (the name of the corresponding LPR channel object) (1);
2. vehicle video frame with a caption, containing the following data (2):
date and time of receiving data about the vehicle;

vehicle speed;

vehicle direction;

speed, allowed on the controlled area of the road;

speed detector ID number;

name of the video camera that detected the vehicle.

-0 20 T

3. identified LP number and the LP image (3).

Note
If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

Using the Auto-Intellect software system - 15
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Note

+ In case the Uragan or CARMEN-Auto module is used for identification, allowed speed, vehicle speed and speed
detector ID number are displayed only if the Radar module is connected (see Auto-Intellect software package:
Administrator's guide).

+ In case the alarm is registered for a vehicle (overspeeding, and /or identification of a plate in the external plates
database), the field with a video frame is highlighted with red (2).

3.3.3 Viewing the data about the last identified vehicle

The last identified vehicle data is displayed in the Last event group of the Online monitor window (left area of this window).

N -I ” . N].T Server status

Processed

Hide

C407TX190

Canera 61

C407TX190

LPR channel 1
2018-09-04 12:03:36

Parameter

| Value

Recognizer

|LPR channel 1

Country

|Russia

Recognition time

|2018—09—04 12:03:36

Speed

|22 km/h

Speed limit

|15 km/h

Speeding

|7 km/h

Validity

lo7 %

Direction

|T0 camera

Regional code

Camera

|Camera 1

A3880K190

LPR channel 1
2018-05-04 12:03:27

P4930A50

LPR channel 1
2018-09-04 12:02:53

P1270Y98

LPR channel 1
2018-059-04 12:02:48

ASOOrNSN

Note

@ b:ib

Videa archive Filter

If there is an event selected in the identified vehicles protocol or in the alarms protocol, the data about this event will be
displayed in the Last event group (see Viewing the protocol of the identified vehicles, Viewing the alarms protocol).

Viewing the data about the last identified vehicle is performed in the following way:

Using the Auto-Intellect software system - 16
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1. The vehicle video frame with a caption is displayed in the filed (1).

10-22-2015 Thu

0 A164BT50
fParameter Value _‘%
Recognizer |LPR channel 1
Country |Russia
Recognition time |2018—DQ—D4 11:20:12
Speed |15 km/h
Speed limit |5 km/h
Speeding |1El km/h
validity |96 %
Direction [To camera
Regional code |
Camera |Camera 1

A

Note

If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

2. Theidentified LP number and the LP image is displayed in the field (2).

3. Depending on the available data, the following information can be displayed in the box (3):

Operator's Guide

a. Inthe Recognizer field, the name of the LP recognizer is displayed (the name of the corresponding LPR

channel object).
b. Inthe Country field, the country to which belongs the identified LP number is displayed.

Note

This field is only displayed when the IntelliVision LPR module is used for recognition.

Using the Auto-Intellect software system - 17
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c. Inthe Recognition time field, the date and time of receiving the vehicle information is displayed.
d. Inthe Speed field, the vehicle speed is displayed.
Note

In case the Uragan or CARMEN-Auto modules are used for identification, and the Radar module is not
connected, zero speed value is displayed.

Note

Depending on the Vehicle Tracer settings, the speed is displayed in km/h or mi/h (see Auto-Intellect
software package: Administrator's guide).

e. Inthe Speed limit field, the speed limit allowed on this part of the road is displayed.
f. Inthe Speeding field, the difference between the captured vehicle speed and the speed limit allowed on this part
of the road is displayed.

Note

This field is displayed if the speeding event was registered, otherwise this field is absent.

g. Inthe Validity field, the identification validity rate is displayed in percent.
h. In the Direction field, the vehicle's direction is displayed (Towards the camera, Off the camera or Undefined).
i. Inthe Regional code field, the regional code of the recognized LP is displayed.

Note

This field can be hidden (see Setting up the Vehicle Tracer interface window).

j. Inthe Camera field, the name of the video camera which captured the vehicle, is displayed.
k. Inthe Address field, the camera location address is displayed.
l. Inthe Identificator (Ne) field, the camera ID number is displayed.

m. Inthe Sertificate (Ne) field, the certificate number is displayed.

n. Inthe Calibration field, the calibration expiration date is displayed.

o. Inthe Type field, the vehicle type is displayed.
Note

This field is displayed only if the Vehicle type recognition module is used.

p. Inthe Dangerous goods class and Dangerous goods composition fields, the class and the contents of the
dangerous cargo are displayed correspondingly.

Note

These fields are displayed only if the CARMEN-Auto module and the Hazard Identification Number
Recognition Engine (ADR) are used.

Viewing the data about the last identified vehicle is complete.

Note

In case an alarm was registered for a vehicle, the reason of alarm is also displayed in the Last event group.

Using the Auto-Intellect software system - 18
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Note

The data about any event selected in the identified vehicles protocol or in the alarm protocol can be viewed in the same
way (see Viewing the identified vehicles protocol, Viewing the alarms protocol).

3.3.4 Viewing the identified vehicles protocol

The identified vehicles protocol is displayed in the On-line monitor window.

g a4
Cars
Processed Show Trace Alarm
Hide All

A164BT50 ]

LPR channel 1
1 2018-08-30 16:43:08

mosnrso |2 1645750

MO96G1ET777 ]
LPR channel 1
Parameter Value = 2018-08-30 16:43:06
Recognizer LPR channel 1
Country |Russia
Recognition time |2D 18-08-30 16:43:08 A721CY97 ]
Speed |14 km/h LPR channel 1
el |5 km/h 2018-08-30 16:43:00
Speeding |2 km/h
Validity 96 Yo e [
En I - Q v ®
LLEET L= 3 Print Search,___Video archive Filter Comment

To access to the protocol, go to the Events tab (1). The identified vehicles protocol is a table which contains the information
about identified vehicles (2).

[ BC1246* l

LPFR channel 1
09.08.2010 9:41:20

l H415TAG3 )2

[ O0*5CCe3 l

LFR. channel 1
09.08.2010 9:41:15

For every vehicle (event) the following data is displayed:

1. video frame of the vehicle (1);
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2. identified vehicle LP number (2);

Note
If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

3. vehicle speed;

Note
Vehicle speed is displayed only if the Radar module is connected (see Auto-Intellect software package:
Administrator guide).

4. LPRchannel (3);
5. date and time of receiving the information about the vehicle (4).

For alarms, the information about reasons of alarms is also displayed (see Alarms operation). The alarms which were not
processed by the operator, are highlighted with red, and processed alarms are highlighted with yellow (see Alarm processing).

Note

Processed events may not be displayed (see Hiding the processed events in the protocol).

To view the detailed information about the event, do the following:

1. Left-click the required event.
2. Asaresult, the data about the vehicle will be displayed in the Last event group. Online update of the identified vehicles

protocol will be suspended.
3. View the data about the event as described in the Viewing the data about the last identified vehicle section.

4. Torestore the online update of the identified vehicles protocol click the Trace button in the upper area of the On-line
monitor window.

. CS90AE*9

4
Processed
Hide

Fs

[ A272MY*0 l

LPFR channel 1
06.09.2010 11:15:13 | .

l B193YA99

LPR. channel 1
06.09.2010 11:15:12

Viewing the detailed data about the event is complete.

3.3.5 Alarms operation
Alarms operation is done in the On-line monitor window.

Alarm is triggered by one of the following ways:
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https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=112525501
https://doc.axxonsoft.com/confluence/display/auto50en/Hiding+the+processed+events+in+the+protocol

Operator's Guide

1. automatically - in case of overspeeding or vehicle's plate identification in the external database;
2. manually.

3.3.5.1 Manual alarm triggering

To enable the manual alarm triggering, do the following:

1. Left-click the required event in the identified vehicles protocol (1).

O O OR
Cars
=, s
v = @
Proceszed Show Trace
Hide All

Al164BT50 l

LPR channel 1
1 2018-08-30 16:43:08

~ mowrso | A16457150

MO9G1ET777 l

LPR channel 1
Parameter |Value = 2018-08-30 16:43:06
Recognizer |LPR channel 1
Country |Russia
Recognition time |2018-08-30 16:43:08 [ A721CY97 l
Speed |14 km/h LPR channel 1
Speed limit |5 km/h 2018-08-30 16:43:00
Speeding |9 kmyh P g
Validity 96 %
Direction l‘l’o camera - O\ ! 2 . ..:l.. ’
Search Video archive Filter Comment

2. Click the Alarm button (2).
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3. Asaresult, this event will be highlighted with red (3), and the Alarms protocol tab will become available (4). For the
alarm which was triggered by the operator, the Marked by the operator cause of alarmis displayed (5).

ONLINE MONITOR Server status

Proceszed
Hide

Al164BT50

LPR channel 1
2018-08-30 16:43:08
Marked by the operator:

MO9G1ET777

LPR channel 1
Parameter value i 2018-08-30 16:43:06

Speed limit 5 km/h
Speeding |9 km/h )
Validity |26 % ) A721CY97

|T° camera 7 LPR channel 1

[Marked by the operator: ) 5. 2018-08-30 16:43:00

Regional code |

Camera |camera 1
A =

Note.

For the information about alarms protocol, see Viewing the alarms protocol.
Manual alarm triggering is complete.

3.3.5.2 Viewing the alarms protocol

The Alarms protocol tab located in the upper area of the Online monitor window (1) automatically becomes available in case of
the alarm event. The alarms protocol is a table which contains the information about the vehicles for which the alarms were
triggered (2).

Note.

The information about the last alarm is displayed on the tab.
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1357 e

E;/ =
(o | ® T
Processed Show Trace
Hide All

T851BT750

LPR channel 1
2018-08-30 17:04:58
Speed: 17 km/h

C407TX190

e I 18518775

LPR channel 1

Parameter Value - 2018-08-30 17:04:25

= Speed: 20 km/h
Recognizer |LPR channel 1 pes il
Country |Russia |
Recognition time |2018-08-3l] 17:04:58 [ 1 T851BT750
Speed |17 km/h LPR channel 1

TR 2018-08-30 16:43:14
Speed limit |5 km/h Marked by the operator:
Speeding |12 kmy/h
Validity |23 % - _

lLEctii .ralHul d Print Search Video archive filter, Comment

The alarms which were not processed by the operator, are highlighted with red, and processed alarms are highlighted with
yellow (see Alarm processing).

Note.

Processed events may not be displayed (see Hiding the processed events in the protocol).

To view the alarms protocol, do the same as to view the identified vehicles protocol (see Viewing the identified vehicles protocol).
The only difference is that for an alarm the information about the alarm reason is also displayed:

1. Marked by the operator - means the alarm is triggered by the operator (the time of triggering is also displayed);
2. Is found in: <external database name> - means the identified LP is found in the external database;
3. Overspeeding - means the vehicle overspeeding is registered.

Detailed information about an alarm with the alarm reason is displayed in the Last event group (see Viewing the data about the
last identified vehicle). To view the detailed information about an alarm, do the same as to view the information about the event,
registered in the identified vehicles protocol (see Viewing the identified vehicles protocol).

In case the identified vehicle LP is found in the External Plates Database, the information about the vehicle, stored in this base,
will be displayed in the field (3).

Note
To display the side panel, click the (4) button.
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i Thy 15:32:4

Parameter

Cancra 01

Value

ONLINE MONITOR

' 215
C407TX190

Database:

' 851BT750

LPR channel 1
2018-08-30 17:04:58
Speed: 17 km/h

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2018—l}8—30 17:04:58

Speed

[17 km/h

Speed limit

|5 kmy/h

|12 km/h

|93 %

C407TX190
LPR channel 1

2018-08-30 17:04:25
Speed: 20 km/h

| | T851BT750 '

LPR channel 1
2018-08-30 16:43:14
Marked by the operator:

Comment:

To camera

3.3.5.3 Alarm processing

Print -

Alarm processing is done in the following way:

o Q

Search

=

Video archive:  Filter

1. Left-click the alarm in the identified vehicles protocol or in the alarms protocol (1).

Server status

10°27- 215 Thy 15:4

Parameter

ONLINE MONITOR

Camera 01

Value

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2l}18—08 -30 16:42:41

Speed

|22 km/h

Speed limit

|5 km/h

Speeding

|17 km/h

Validity

Direction

2. Click Accept (2).

, 5
C407TX190

Server status

' 407TX190

LPR channel 1
2018-08-30 16:42:41
Speed: 22 km/h

Al164BT50

LPR channel 1
2018-08-30 16:40:39
Speed: 15 km/h

MOG1ET777

LPR channel 1
2018-08-30 16:40:37
Speed: 15 km/h

o]

Video archive Filter
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10-2#- 2815 The 15:1;: &3

sl

e

Canera 01

oz,

cwrmasn [C4077x

Parameter | Value

Recognizer |LPR channel 1

Country |Russia ]
Recognition time |2018—03—30 16:42:41 3
Speed |22 km/h

Speed limit |5 km/h

Speeding |17 km/h

Validity |84 %

Direction 0 camera

Alarm processing is completed.

3.3.5.4 Hiding the processed events in the protocol

I
= ) a
Show Trace Ale:rrn
All
-

|

LPR channel 1
2018-08-30 16:42:41
Speed: 22 km/h

A164BT50

LPR channel 1
2018-08-30 16:40:39
Speed: 15 km/h

M961ET777

LPR channel 1
2018-08-30 16:40:37
Speed: 15 km/h

4

Q B

Itis possible to hide the processed events in the identified vehicles protocol and alarms protocol. To do this, click the Processed
Hide button. As a result, when all alarms are processed, then the Alarms protocol tab becomes hidden.

Using the Auto-Intellect software system - 25



'S Thie 1548 y .

Canera 01

sz (1961ET1TT)

Operator's Guide

40 =1
|
- ® a2
Show Trace Alarm
All
I [ ¥ 1ETYT 777 ]
M96
L - |
LPR channel 1

2018-08-30 17:10:56
Speed: 15 km/h

I lParameter Ir‘o’alue
Recognizer |LPR channel 1
Country |Russia
Recognition time |2018-08-30 17:10:56 3
Speed |15 km/h
Speed limit |5 km/h
Speeding |10 km/h
validity log =%
Direction 0 camera

[—aua&ma—l

LPR channel 1

2018-08-30 17:10:46
Speed: 15 km/h

C407TX190

LPR channel 1

2018-08-30 17:10:32
Speed: 20 km/h

Q

3.3.5.5 Viewing the alarm information in the Alarm window

2 L

Depending on the certain configuration, the Alarm window can be displayed automatically in the following cases:

1. If the recognized license plate number coincides with the number stored in the external online monitoring database. As a
result, the Report of vehicle found in DB ;o \i|| be displayed at the top of the alarm window.
2. Ifthe alarm event was triggered manually. As a result, the Marked by the operator: sign will be displayed at the top of

the alarm window.
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Report of wehicle found in DB Marms in total:
i 2018-08-29 17:-50:37
Licenze plate KE73¥K163
Recognition server LPR channel 1
Direction To camera
Intemal Vehicles DB Extemal Flates DB 1
Qtate: Mot confimed
Field Value
| a2cH8chf-G9abe811-aa18-1cTblda’bidd
License plate number | KE73VK183
Storage time
Active for search | Yes
Date/time of creation | 29.08.2018 17.42:08
Comment |
@erator
Lr ]
 — 5 6
C<< < > e Follow Approve (information sent) Disapprove

The following data is displayed in the Alarm window:

1. Eventinformation (1):
« Date and time when the alarm event was recorded.
« License plate number.
+ Recognition server name that recorded the event.
« Vehicle direction of movement relative to the camera.
« Name of the external database.

Note

Operator's Guide

The field with the name of the external database is hidden if the the alarm event was triggered manually.

« Current state of the alarm event.

Note

There can be the following states of the alarm event:

+ Not confirmed - a new event that has not yet been confirmed.
« Processing... - an alarm event is confirmed, but the information has not yet been recorded to the

database.

+ Confirmed - the alarm is confirmed and recorded to the database (you may not notice this state

since the event is deleted from the Alarm window after a successful confirmation).

« Error - the confirmation is not recorded to the database due to the heavy load on the Server. It is

necessary to confirm the event again.

2. The description from the stolen vehicles database (2): ID, LP number, storage time, search status, date and time of
creation, comment, full name of the operator who created the report.
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Note

The table with the description from the stolen vehicles database is hidden if the the alarm event was triggered
manually.

Use buttons to scroll the alarm events (3).

To confirm the active alarm status, click the Approve (information sent) button (5). As a result the alarm will be marked as
received in the On-line monitor window, and deleted from the Alarm window. If the Follow checkbox is set (4), the confirmed

alarm will be deleted from all Alarm windows in the distributed system.

To close the window of stolen vehicle report click the Disapprove button (6). If you click this button, the alarm status will not be
changed in the On-line monitor (alarm will not be processed).

3.3.6 Adding comments to the events

Itis possible to add the comments to the events. It can be done in the Online monitor window.

Attention!
It is not possible to add the comments to the accepted events (highlighted with yellow).

To add a comment to the event, do the following:

1. Left-click the eventin the identified vehicles protocol or events protocol (1). Online update of the protocol displayed on
the screen will be suspended.

O O
Da

D 0 0

Cars
v = gfe
rooEssad “Shaw Trace

Hide Al -

-

A3880K190 l

LPR channel 1
2018-08-30 17:17:51

Camcra 81

i ——
A3880K100 | 388 | [ l
A 0K 1‘9!9 P1270Y98 y
= — 3 LPR channel 1 30-08-2018 17:22:03:
Par Value 2018-08-30 17:17:15 Comment
Recognizer LPR. channel 1
Country |Russia
Recognition time |2{]18—l}8—30 s | [ A164BT50 I
Validity |98 kL LPR channel 1 4
Directian |undefined 2018-08-30 17:17:14
Regional code |
Camera |Camera 1 <
o™ o & s (o®
Print - ‘Search  Video archive: Filter Comment

2. Click Comment button (2).
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3. Comments for license plate window will open in result.

4. Inthe Enter new comment field (5), specify a required comment.
5. Click the Add button (6) to add the comment to the event.

Note

The Comments for license plate <LP number> field (3) displays the previous comments, if any, and the date
when they were added to this event.

6. Toview the comments to the event, left-click the required event in the identified vehicles protocol or events protocol.
Comments will be displayed in the corresponding field (4).

Note
To display the side panel, click the (7) button.

7. Toresume the online update of the protocol, displayed on the screen, click Trace button (3).

Adding the comments to the event is completed.

3.3.7 Printing and exporting the vehicle data

Printing and exporting the vehicle data is done in the following way:
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1. Left-click the event in the identified vehicles protocol or events protocol (1). Online update of the protocol, displayed on

the screen, will be suspended.

949TTN ]‘a‘aa =

Parameter [value
Recognizer |usa channel
Country usa
ion time [2016-07-22 13:23:58
Speed o kmsh
Validity lo1 %
Direction |undefined

Regional code

Basic color of license plate IC

Extra color of license plate IC

949TTN

Pe£le

E351SW

rerl

Arab channel
2016-07-22 13:23:41

437TSX

Usa channel
2016-07-22 13:23:39

2 S:kh Vid Eln ;:nh C ,m
2. To build a report with vehicle data, click the Print button (2).
3. The report preview program will be displayed.
& Vehicle data - Preview report x
Eile  Wiew Mavigate Document Help
SMEGERSEDQ || EE DR [ OE] [
& Intellect
Vehicle data
Recognizer Arab channel
Country United Arab Emirates: Abu Dhabi
Recognition time 2016-07-22 10:23:04
Speed 0 km/h
Validity 62 %
Direction Undefined
Regional code
Arab channel

4.

Yeeg

If necessary, do the following operations with the report, then quit the report preview program by clicking the File -> Exit
viewer in the main menu, or by clicking the I buttonin the top right corner.
The available operations for the report are listed in the table below.
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Operation

Open the report, saved in .rsd or .xml

Save the reportin .rsd or .xml

Export the report to one of the common formats

Print the report

Activate the «Hand» tool

Zoom in the report pages

Zoom out the report pages

Enable dynamic scaling of report pages

Zoom in the selected area of the report

Scale in page size

Scale in page width

Display pages in real size

Enter or select from the list the required scale of displaying the report

pages

Enable the nonstop paginal report displaying

Enable the page-by-page report displaying

Go to the first page

Go to the previous page

Go to the next page

Operation +invocation

Main menu -item

File -> Open

File -> Save

File -> Export

File -> Print

View -> Scrolling

View ->Zoom in

View -> Zoom out

View -> Dynamic scaling

View -> Region scaling

View -> In page size

View -> In page's width size

View -> Real size

View -> Set the scaling

Navigate -> The first page

Navigate -> Previous page

Navigate ->The next page
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Context menu -+item

Scrolling

Zoom in

Zoom out

Dynamic scaling

Region scaling

In page size

In page's width size

Real size

Set the scaling

The first page

Previous page

The next page

Toolbar
button

88 %



Operation

Go to the last page

Go to the certain page (open the «Go to page» dialog window)

Display the previous view

Display the next view

Find the required characters in the report

Update the report

Edit the report (open the editing program)

Display table of contents

Display information about the program to view the report

Close the preview report program

Note.

Operation +invocation

Main menu -item

Navigate ->The last page

Navigate -> Go to page

Navigate -> Back

Navigate -> Forward

Document -> Find

Document -> Update

Document -> Edit the report

Help -> About program

File -> Close

Operator's Guide

Context menu -+item

The last page

Back

Forward

Find

Update

Edit the report

Toolbar
button

-

Operations with report files (opening, saving, exporting, and printing) are performed via the standard OS

Windows dialog windows.

Note.

To go to the required page, enter the page number in the Page Ne field of the Go to page dialog window and

then click OK.

Printing and exporting the vehicle data is completed.

3.3.8 Viewing the video archive by event

In the On-line monitor component, it is possible to initiate the video archive playback by the event via the Monitor interface

window.

Note.

The pre-configured Monitor object should be selected as a controlling monitor on the Vehicle Tracer settings panel

(see Auto-Intellect software package: Administrator Guide).

To view the video archive by event, do the following:
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1. Left-click the event in the identified vehicles protocol or alarms protocol (1). Online update of the protocol displayed on
the screen will be suspended.

ONLINE MONITOR Server status

= 416
C407TX150

A3880K190

i LPR channel 1
Canern 01 2018-08-30 17:17:51

A3880K190 'A3BBOK’1Q.Q] [ P1270Y08

s LPR channel 1
Parameter Value 2018-08-30 17:17:15

Recognizer LPR channel 1
Country |Russia
Recognition time |z018-08-30 17:17:51 ! [ A164BT50
Validity |98 2 . LPR channel 1

Direction |Undeﬁned 2018-08-30 17:17:14

Regional code |

Camera |camera 1

2. Click Video archive (2).

3. In case the monitor with a video surveillance window corresponding to the LP recognition camera is displayed on the
screen at the moment, this video surveillance window will switch to the video archive playback by the event mode. For
details about video archive navigation, see Intellect software package: Operator's Guide.

=mEQ 0001 020G 04 05 06 07 05 02 10 1 12 15 4 15 16 17 15 19 a0 21 22 25 24

10:49:42
10:50:02
10:50:22
10:50:49
10:51:16
10:51:36
10:51:56
1052116
10:52:36
10:53:07
111059
111112
i3l il gl
111201
11i12:16
111125
111241
11:113:01
11:13:30
11113149
11:14:09
14072

4 rpnE I P

Note

To exit the video archive displaying mode, left-click the 'ﬁ sign in the right bottom corner of the video
surveillance window.

Viewing the video archive by event is completed.
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3.3.9 Usingfilters in the protocols

You can select events to be displayed in the identified vehicles protocol and alarms protocol.

Attention!

Both displayed and hidden in the protocol events are saved in the recognizers database of the Auto-Intellect software.

You can select the events using the following filters:

1. speed;
overspeeding;
license plate;
validity;

region;

direction;

alarm type;

8. plate recognizers.

Nouok~wbhN

To select the filter, do the following:

1. Click Filter button in the On-line monitor window (1).
: ONL[E M-NITO . Server status

10-Z2-2015 Thu 1h:

Al164BT50

- T LPR channel 1
Canera 01 2018-08-30 17:17:14

A164BT50 A 1€4BT .Q_] | MOG1ET777

f LPR channel 1
Parameter Value 3 2018-08-30 17:17:12

Recognizer LPR channel 1

Country |Russia
Recognition time |2018-08-30 17:17:14 : =¥ A721CY97

Validity |29 % LPR channel 1

Direction |Undeﬁned 2018-08-30 17:17:03

Regional code |

Camera |Cam eral
_ X E2 1

Video archive
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2. Filters dialog window will be displayed in result.

speed, kmjh

I Mo filtering

Speeding, kmfh
I No filtering

License plate

| Mo filkaring

Validity

I No fittering

Region

I Mo filkering

Direction

I No filtering

Alarm type

I No filtering

Plates recognizers

3. From the Speed list (1) select the required filter, then specify the speed value(s) in the field(s) in km/h.
The following speed filters are available:
+ No filtering — the event is displayed in protocols with any vehicle speed.
« More — the event is displayed in protocols if the vehicle speed exceeds the specified value.
+ Less — the eventis displayed in protocols if the vehicle speed is below the specified value.
+ Interval — the event is displayed in protocols if the vehicle speed is within the specified speed range.

4. From the Speeding list (2) select the required filter, then specify the overspeeding value in the field in km/h.
The following overspeeding filters are available:
+ No filtering — the event is displayed in protocols with any vehicle overspeeding.
« More — the event is displayed in protocols if the vehicle overspeeding exceeds the specified value.

Note.

The overspeeding value is calculated as the difference between the recorded vehicle speed and the
speed, permitted in the controlled area of the road.
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5. From the License plate number list (3) select the required filter and then in the field enter the LP number or its part which
identification leads to event displaying in protocols.
The following LP filters are available:
+ No filtering — the event is displayed in protocols with any vehicle LP number.
+ Register — the event is displayed in protocols if the vehicle LP number exactly matches the specified value.
« Contains — the event is displayed in protocols if the vehicle LP number contains the specified value.

Note.

The value specified for the Register and Contains filters may include usual characters and «*» characters
which stand for an unidentified LP character. If the value contains one or several «*» characters, only the
LPs which contain the unidentified characters in the specified combination, are displayed in the
protocols.

6. From the Validity list (4) select the required filter of the LP recognition validity percentage, then specify the percentage
value in the field(s).
The following validity filters are available:
+ No filtering - the events are displayed for those vehicles which plates are recognized with any validity.
+ More - events are displayed in the protocol if the recognizing validity is higher than the specified value.
+ Interval - vehicle event is displayed in the protocol if the recognizing validity of vehicle plate belongs to the
specified range of values.

7. From the Region list (5) select the required region filter, where the vehicle has been registered, and then enter the region
number in the field.
The following region filters are available:
+ No filtering — the events are displayed in protocols for the vehicles, registered in any region.
+ Equal — the events are displayed in protocols for the vehicles, registered in the specified region.

8. From the Direction list (6) select the vehicle direction for which the event should be displayed in protocols.
The following direction filters are available:
+ No filtering — the events are displayed in protocols with any vehicle direction.
« From camera — the event is displayed in protocols if the vehicle was moving away from the camera.
+ Towards the camera — the events are displayed in protocols if the vehicle was moving towards the camera.
+ Undefined — the events are displayed in protocols if the vehicle direction was not determined.

9. From the Alarm type list (7) select the alarm type. Only alarms of the selected type will be displayed in protocols.
The following alarm type filters are available:

+ No filtering — the events are displayed in protocols with any alarm type or its absence.

« Overspeeding — the events for which overspeeding has been registered are displayed in protocols.

« LP found in database — the events for which the LPs have been found in the external plates database are
displayed in protocols.

« Alarm set by operator — the events, initialized manually, are displayed in protocols.

« Running ared light — the events for which the red lights running has been registered are displayed in protocols.

+ Entered the oncoming lane — the events for which the entering the oncoming lane has been registered are
displayed in protocols.

+ Crossed the stop line — the events for which the crossing the stop line has been registered are displayed in
protocols.

+ Stop over crosswalk line - the events for which the stopping on the crosswalk line has been registered are
displayed in protocols.

10. Inthe Plates recognizers (8) group set the checkboxes for those LP recognition Servers, which data should be displayed
in protocols.
11. Click OK to save filters settings and close the Filters dialog window (10).

Note.
To reset all the settings, click the Reset button (9).

Filtering the events to be displayed in the protocols is complete.
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Note

You can disable any filtering without changing the settings in the Filters dialog window. To do this, click the Show all
button (2). All the registered events will be displayed in protocols in result. To resume the usage of filters, click this
button again.

3.3.10 Viewing the Vehicle Tracer errors

If there are no Vehicle Tracer errors, the Server status button in the right upper corner of On-line monitor window is green

.If errors are registered, the button is red

ON NE MONITOR Server status

" 416
10-72-2015 Thu 1% i C407TX150

Al164BT50

W I LPR channel 1
Camera 01 20138-08-30 17:17:14

A164BT50 [_A 1645]" e MOO1ET777

/ LPR channel 1
Parameter |Value 4 2018-08-30 17:17:12

Recoagnizer |LPR channel 1
Country |Russia - )
Recognition time |2018—03—3l] 17:17:14 N ¥ | A721CY97
Validity |99 % ! LPR channel 1

Direction |Undeﬁned ! e 2018-08-30 17:17:03

Regional code |

Camera |Camera 1 O\

& *

Video archive Comment

To view the Vehicle Tracer errors, do the following:

1. Click the Server status button.
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2. The Errors dialog window will be displayed in result.

3. The data about the occurred errors is displayed in the field (1).

4. The list of all possible error sources is displayed in the field (2): LPR channels and/or external databases. Current error
sources are marked by the @ sign, idle sources are marked by the @ sign.

5. To delete the data about the errors and close the Errors dialog window, click the Clear button (3).

6. To close the Errors dialog window without deleting the data about the errors, click the . button.

Viewing the Vehicle Tracer errors is completed.
3.3.11 Creating the additional Online monitor components

It is possible to create the additional Online monitor interface components. To do this, double left-click the Events monitor
component. As a result, the additional Online monitor component will be displayed in the center of the screen.
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ADDITIONAL ONLINE MONITOR - 1 (LPR channel 1) Server status Bl %
05 Tha 1542040 ]
S - A
Show Trace e W S
All
I T939CC197 l
LPR channel 1 |
2018-08-30 17:40:48
e B
L T851BT|750 | | T851BT750 |
2 LPR channel 1
Parameter Value 2018-08-30 17:40:40
Recognizer LPR channel 1
Country |Russia
Recognition time |201B—08—30 17:40:40 I P1270¥98 l
Validity |g7 % LPR channel 1
B |undefined 2018-08-30 17:40:36
Regional code |
Camera |camera 1 - —
- & = 5[ -
Print Search Video archive Filter Comment

Working with Additional Online monitor components is similar to working with the main Online monitor component.

3.3.12 Searchingthe events in the recognizers databases

3.3.12.1 Openingand closing the Event search in the Recognizers DBs window

You can search the events in the the Auto-Intellect recognizers databases via the Event search in the Recognizers DBs dialog

window.

The full list of operations provided to the operator in the window Event search in the Recognizers DBs, is the following:

1. Searching the events, stored in the Auto-Intellect|ocal or remote recognizers databases.
2. Printing the search results reports.

3. Creating the personal LPs database (Active tracking database).

To open this window, click the Search button in the On-line monitor interface object.
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Alarm

T851BT750

LPR channel 1
2018-08-30 17:42:58

'Parameter

| Value

Recognizer

|LPR channel 1

Country

|Russia

Recognition time

|20].8—'l]8—3l] 17:42:58

Validity

[o7 %

Direction

|Undefined

Regional code

Camera

|Camera 1l

l P1270Y98

LPR channe| 1
2018-08-30 17:42:54

|

LPR channel 1
2018-08-30 17:42:51

-8

As a result, the Event search in the Recognizers DBs window will be opened.

File | View  Settings

Print

by alams

Servers  Internal SVDEB=

Export...

Exit 3

AND

-

-

Partly recognized

Flate region:

[] License plate not recognized

Regional code:

LP colors:
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To minimize the Event search in the Recognizers DBs window, click the (1) or (2) buttons. As a result, the window will be
minimized to the Taskbar but will continue working.

To close the Event search in the Recognizers DBs window, select the File -> Exit item in the main menu (3). As a result, the
window will be closed completely.

3.3.12.2 Configuring the events search

On the page:

+ Selecting the recognizer
databases for the events search

+ Configuring the search results

+ Configuring the video archive

Events search is set up in the following order:

1. Select the database, where events should be searched.
2. Configure the displaying of search results.
3. Configure the video archive.

3.3.12.2.1 Selecting the recognizer databases for the events search

To select the recognizer databases for events search, first select the servers where the required LPR databases are. To do this,
click the Servers -> <Name of the required database> in the main menu of the Event search in the Recognizers DBs window.

The selected server will be marked with |T| icon.

oy

ﬂ Event search in the Recognizers DEs

File View Settings | Servers | Internal SVDEs
Select all

LOCALHOST[127.0.0.1:10001:]

Search by vehicles | Search

Vehicle's license plate: ‘

Note.

To select all system servers, click Servers -> Select all.

The search will be performed in the selected servers.

Note.

If some of selected servers is unavailable for search, the Results of search on the server heading will be highlighted
with red. If all servers are available for search the heading will be highlighted with green.

3.3.12.2.2 Configuring the search results

Event search results are displayed in the table. You can choose which table columns should be displayed and which shouldn't,
add new columns and also edit the columns displayed names.

To configure the search results displaying, do the following:
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1. Inthe main menu of the Event search in the Recognizers DBs, click Settings.

Event search in the Recognizers DBs

File  View Servers  Internal SWDBs

Search by vehicles | Search by alams |

As a result the Settings dialog window is displayed. The search results displaying is configured on the Configure fields

tab.

Settings

Corfigure fields

Configure video archive

-

[] Mumber

LP region

Courtry
Date

License plate
Regional code
Recognizer name
Vehicle speed

Recognizer address
[¥] Valid speed, km/h

:! Select’deselect

5 6
| oK || Cancel |

2. Inthefield (1) set the checkboxes for the columns that should be displayed in search results table.

Note.

To display all the available columns in the search results table, set the Select\deselect checkbox (2). If this
checkbox isn't set, the search results table is not displayed.

Column name (by default)

Frame

LP number

Number

Region number

Region

Detector name

Column content

Video frame with a vehicle

Video frame with vehicle LP number

Identified LP number

Region number of the identified number

Region of the identified LP number

LPR channel object name, corresponding to the vehicle detector
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Column name (by default)

Vehicle speed
Country

Date

Detector address

Valid speed, km/h

Overspeed, km/h

Direction

Authenticity, %

Alarm time

Alarm initiated by

Alarm accepted by

Alarm detection time

Delay of alarm acceptance, sec

Commentary

Alarm type

Alarm processed

External database

Red-light phase start time

Time passed since the red-light phase start

Category
Camera

Type

Frame from a synchronous camera

Dangerous goods class

Operator's Guide

Column content

Vehicle speed
The country of the recognized LP number

Date and time of the vehicle identification

LP detector address

Speed in km/h permitted on the road area covered by the detector

Vehicle overspeeding in km/h

An indication that the vehicle was moving towards the detecting camera

LP identification accuracy in percent

Time of the LP detection alarm registration

Name of the operator who initiated the alarm

Name of the operator who processed the alarm

Time of the LP detection alarm acceptance by the Auto-Intellect operator

Time between registering the alarm and its acceptance by the operator

Comment on the event added by the operator

Alarm type (overspeeding or vehicle identification in the external plates
databases)

An indication that the alarm was accepted by the operator

An indication that the alarm was found in the external plates database

Time of the red-light phase start during which the alarm was registered (if the
Red lights running module is used)

Time between the red-light phase start and the alarm registration (if the Red
lights running module is used)

Vehicle category identified by license plate

Name of the video camera which captured the vehicle

Vehicle type (if the Vehicle type recognition module is used)
Video frame from a synchronous video camera displaying a vehicle

Class of the dangerous cargo (if the CARMEN-Auto module and the Hazard
Identification Number Recognition Engine (ADR) are used)
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Column name (by default) Column content

Dangerous goods composition Contents of the dangerous cargo (if the CARMEN-Auto module and the
Hazard Identification Number Recognition Engine (ADR) are used)

3. To add a new column to the search results table, do the following:

3.1 Click Add (3). As the result the Configure fields dialog window will be displayed.
Configure fields @

Field name in the DB:

| 1

Field name in the interface:

3| Save || Cancel Id.

3.2 In the Field name in the DB field, specify the name of the column in the connected recognizer database, which
content should be displayed in the search results table (1).

3.3In the Field name in the interface field, specify the name for this column which should be displayed in the search
results table (2).

3.4 Click Save to save the applied changes and close the Configure fields dialog window (3).

Note.

Click Cancel to close the window without saving any changes (4).

. To edit the column name in the search results table, do the following:

4.1 In the Configure fields group select the column, which name should be changed (1).

4.2 Click Edit (4).

4.3 As aresult the Configure fields dialog window with the disabled Field name in the DB field is displayed.

Configure fields @

Field name in the DB:

frames preview_frame

Field name in the inteda

I Save | | Cancel

4.4 In the enabled Field name in the interface field, specify the new column name and save the changes (see steps
4.3-4.4).

. Click OK to save the changes and close the Configure fields dialog window (5).

Note.

Click Cancel to close this window without saving any changes (6).

Configuring the displaying of the search results is completed.

3.3.12.2.3 Configuring the video archive

Video recordings of the events are displayed in the video archive. To configure the video recordings playback, do the following:
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1. Inthe main menu of the Event search in the Recognizers DBs, click Settings.

ﬂ Event search in the Recognizers DBs

File  View Servers  Internal SWDBs

| Search by vehicles | Search by alams i

As a result the Settings dialog window is displayed.
2. Go to the Configure video archive tab (1).

Settings @

-

| Configure fields | Corfigure video archive | 1

Owverday
| Overay 2 -2
4 Compression iy
Diefault Mone Mamdmum
M o

4
| oK || Cancel |

3. From the Overlay dropdown list, select the Overlay mode (2).

Note.

Overlay is used to process the video using the video card and Direct X libraries, before it is displayed. Overlay
allows to improve the image due to optimization of the pixel color settings. At the same time, the CPU load is
reduced as the video is processed with the resources from the video capture card.

The overlay modes are presented in the table.

Overlay mode Description
No Videos from the video cameras are not processed by the video card.
Overlay 1 Videos from the video cameras are processed as one stream.

Overlay 2 (set by default) ~ Videos from the video cameras are processed independently of one another.

4. Inthe Compression field, set the cursor according to the required video compression rate (3).
« Default — means the original compression rate, size and quality of the video corresponds to the video image that
is sent to the server.
« None — means minimal compression rate, full video size, best quality.
« Maximum — means maximum compression rate, minimal video size, worst quality.
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5. To save changes click OK (4).

The configuring of the video recordings playback is completed.

3.3.12.3 Creating the search query

On the page:

+ Creating the search query by
vehicles

+ Creating the search query by
alarms

It is possible to form a search query:
1. Byrecognized vehicles;
2. Byalarms.
3.3.12.3.1 Creating the search query by vehicles

To create the search query by vehicles, do the following:

Operator's Guide
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1. Go to the Search by vehicles tab.
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Search by vehicles | Search by a]anﬂs|

Wehicle's license plate:

Search operation: 1

[] License plate not recognized 3
[ Partly recognized
[] "Space’in car number

[ Acceptable emor amount 6

Reqgional code:

[ <not specified>

m

LP region:

[] <not specified>

LP colors:

[] =not specified:

10

Date/Time

from: |[C] 2020-05-28 13:24:10

to: |[F]2020-05-28 13:24:10

Plate recognizers:

LPR channel 1

12

Registered speed:

| <nct important >

13

s:-;-f-_;![:- o to: |0 :|14

Dlirection: [mu matter:

119

Courtries:

[] =not specified>

16

Comment:

Cearh anerstion: arn - 1T
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From the Search operation list (1) select a logical construction, used for uniting several elements of the key phrase,
which correspond to the LP numbers or their parts that are being searched:

a. AND - for searching by numbers, containing all the elements of the key phrase;

b. OR -for searching by numbers, containing at least one element of the key phrase.
In the Vehicle's license plate (2) field, enter the key phrase. The elements of the key phrase can be separated by comma

," orsemicolon";".

Note.

The key phrase may include usual characters and picture-characters in the required combination.

Picture-characters Description of Picture-characters Example of search query
% Any string in length from zero and more Search query a%385%78 returns LP numbers, containing
characters the elements 'a’, '385' and '78', divided by any number of

characters, for example 'AO38578', 'a385mk78'

_ (underlining) Any single character Search query 2__5 returns LP numbers, containing the
sequence of four characters, the first of which is '2', the last
oneis '5',for example, 'A256577', '21150K43'

[ Any single character within the range ([a-€]) or Search query [e-m][2-5]53 returns LP numbers, containing
in the set ([abcde]) the sequence of four characters. The sequence ends in '53',
the first character belongs to the range e-m, the second one

belongs to the range 2-5, for example, 'k453mn02',

'm253bt63'
[ Any single character outside the range ([*a-€]) Search query [*e-M]499 returns LP numbers, containing the
or the set ([*abcde]) sequence of four characters. The sequence ends in '499', the

first character does not belong to the range e-m, for example
'b499bk57', 'n499578"

Set the License plate not recognized checkbox (3) if it is necessary to display all the numbers.

Note.

Selection of the checkbox License plate not recognized is enabled only if the OR logical construction is selected
in the Search operation dropdown list.

Set the Partly recognized checkbox if it is necessary to display partially recognized numbers (4).

Set the 'Space’' in car number checkbox (5) if it is necessary to display the numbers that contain a space between the
characters.

In the Plate region group set the checkboxes for those regions, which events should be returned while being searched (6).
In the Regional code group set the checkboxes for those regional codes events for which should be returned while being
searched (7).

In the LP colors group select color of regional code and basic color of the license plate (8).

In the Date/time group (9, 10) set the time range within which the required events have been registered. By default this
range is not activated (checkboxes from and to are disabled). To activate it, set the checkboxes From and/or To and then
click 7 button (9-10) and in the appeared calendar set the required date. Enter the required time in the field From and/
or To. If only upper or bottom boundary is selected, the search query will return the events, registered before or after the
set deadline correspondingly. To disable the search by date and time, uncheck From and To checkboxes.

In the Plate recognizers group (11) set the checkboxes for those plate recognizers, which events are to be returned while
being searched.
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13.

14,

15.

16.

17.

18.
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Note.

By default, information about objects removed from the Intellect software package is not displayed in the Plate
recognizers group. Select Show deleted in the View menu of the Event search in the Recognizers DBs main
window to search by removed servers of plate recognizers. After this all removed servers of plate recognizers will
be displayed in the Plate recognizers group. Set checkboxes for those plate recognizers which will be used while
being searched.

ﬂ Event search in the Recognizers DEs

File | View | Settings Servers Internal SVDEs
[ | * | Show deleted F [
[Seart| 7] |

L |

=+

From the list Registered speed (12) select the required filter of vehicle speed and then in the activated field(s) (13) enter

the threshold value(s) of vehicle speed.

The following speed filters are available:

a. No matter - events of the vehicle, moving with any speed will be returned.

b. More - events of the vehicle, moving with a speed, exceeding a single threshold value, will be returned.

c. Less - events of the vehicle, moving with a speed, not exceeding a single threshold value, will be returned.

d. Interval - events of the vehicle, moving with a speed, belonging to a single entered threshold value, will be
returned.

From the Direction list (14) select the required filter concerning the direction of the vehicle. The following direction filters
are available:

No matter - events of the vehicle, moving in any direction concerning the LP recognizer's camera will be returned.
Undefined - events of the vehicle, which direction could not be defined, will be returned.

From the camera - events of the vehicle, moving away from the LP recognizer's camera will be returned.

To the camera - events of the vehicle, moving towards the LP recognizer's camera will be returned.

To the right - events of the vehicle, moving to the right of the LP recognizer's camera will be returned.

To the left - events of the vehicle, moving to the left of the LP recognizer's camera will be returned.

-0 Q0 T o

In the Countries group (15) set the checkbox for the country, which events should be returned while being searched.

Attention!

Only the countries whose license plate numbers have already been recognized earlier are displayed in the
Countries group, since the information about the countries for this filter is taken from the recognized plates
database.

From the list Search operation (16) select a logical construction, used for uniting several elements of the key phrase,
corresponding to the comments, that are being searched:

a. and - for searching by comments, containing all the elements of the key phrase;

b. or - for searching by comments, containing at least one element of the key phrase.

In the Comment field (17) enter the key phrase, containing one or several comma separated elements, corresponding to
the comments to the events, which are being searched, and which were specified in the Online monitor window (see
Adding comments to the events).

Set the Empty comment checkbox to include the uncommented events in the search (18).

Note.

The selection of the Blank comment checkbox is enabled only if the OR logical construction is selected in the
Search operation dropdown list..

From the Validity list (19) select the required Validity filter and then in the activated field(s) (20) enter the threshold of
Validity value(s) in percent. The following Validity filters are available:
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a. No matter - events of the vehicle, which numbers have been recognized with any validity.

b. More - events of the vehicle, which numbers have been recognized with validity, exceeding the entered threshold
value in percent.

c. Less - events of the vehicle, which numbers have been recognized with validity, not exceeding the entered
threshold value in percent.

d. Interval - events of the vehicle, which numbers have been recognized with validity, belonging to the entered
threshold value in percent.

19. Inthe Recognition cameras field (21) set the checkboxes for the cameras, which events should be returned while being
searched.

Creating the search query by events is completed.

After creating the search query, run its processing (see Query launching).

3.3.12.3.2 Creating the search query by alarms

To create the search query by alarms, do the following:
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1. Goto the Search by alarms tab.
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Vehicle's license plate:
Search operation: AND -

License plate not recognized
[ Partly recogrized
[ "Space’in car number
[] Acceptable emor amourt

Regional code:

m

[] <not specified=

LP region:

[ <not specified:=

LF calors:

N,

[ <not specified=

Date/Time
from: [] 2020-05-28 13:24:11

to: [0 2020-05-28 13:24:11

Plate recognizers:

LPR channel 1

Fegistered speed:

[dnnt important =

Iy
u

[ =)

Exdemal DB:

[] Extemal Plates DB 1
[] Extemal Plates DB 1
[] Extemal Plates DB 2

Pemitted speed:
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. Repeat steps 2-12 of the section Forming the search query by events as applied to interface elements of the tab Search
by alarms (1).
. Inthe group External DB (2) set the checkboxes for those external databases, which events have to be returned in search
query results.

Note.
This setting is enabled if the checkbox Plate number is found in the DB is set in the Alarm type group (9).

Note.

The External database group contains a list of all the databases that have ever been used together with the
Vehicle Tracer module but, by default, databases removed from the /ntellect software package are not
displayed in the list. Select the Show deleted in the View menu of Event search in the Recognizers DBs main
window to search by removed servers of plate recognizers. As a result, all external databases removed from the
system will be displayed in the list. Set checkboxes for those databases which will be used while being searched.

ﬂ Event search in the Recognizers DEs
File | View | Settings Servers Internal SVDEs

S_E_'F_'_"FE!-'E Show deleted F i__

L |

=+

. From the Permitted speed list (3) select the required speed filter, permitted on the controlled road area and then in the
activated field(s) (4) enter the threshold speed value(s) in km/h.

The following filters of the permitted speed are available:

4.1 No matter - events of the vehicle, registered on the road area with any permitted speed will be returned.

4.2 More - events of the vehicle, registered on the road area with any permitted speed, exceeding the entered threshold
value will be returned.

4.3 Less - events of the vehicle, registered on the road area with any permitted speed, not exceeding the entered
threshold value will be returned.

4.4 Interval - events of the vehicle, registered on the road area with any permitted speed, that belong to the entered
threshold value range will be returned.

. From the list Alarm handling delay, sec (5) select the required filter according to the alarm handling delay and then in
the activated field(s) (6) enter the threshold value(s) of delay time in seconds.

The following filters of alarm handling delay are available:

5.1 No matter - alarms, accepted in any time after being registered or unaccepted at all.

5.2 More - alarms will be returned, accepted with a delay, exceeding the entered threshold value.

5.3 Less - alarms will be returned, accepted with a delay, not exceeding the entered threshold value.

5.4 Interval - alarms will be returned, accepted with a delay, belonging to the entered threshold value.

Note.

This setting is enabled if the values No matter or Processed are selected from the Alarm processed list.

. From the list Alarm processed (7) select the required filter according to the alarm processing factor:
a. No matter — both processed and unprocessed events will be returned.

b. Alarm is not processed — only unprocessed events will be returned.

c. Alarm processed — only processed events will be returned.

. Inthe Alarm accepted by group (8), set the checkboxes for the operators who received the alarm events to display these

events in the search query.

. Inthe Alarm type group (9), set the checkboxes for the alarms, which have to be returned in results of search query:

a. Stop over stop line — events will be returned for which stopping over the stop line at the stoplight has been
registered.
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Entered the oncoming lane — events will be returned for which entering the oncoming lane has been registered.

Parking violation — events will be returned for which the violation of parking rules has been registered.

Marking rules violation — events will be returned for which the violation of marking rules has been registered.

LP found in database — events will be returned which plates have been found in the external database.

Stop over crosswalk line - events will be returned for which stopping over the crosswalk line at the stoplight has

been registered.

Overspeeding — events will be returned for which overspeeding has been registered.

Running a red light — events will be returned for which running a red light has been registered.

i. Running a red light at crossroads — events will be returned for which running a red light at crossroads has been
registered.

j. Alarm is set by operator — manually triggered alarms will be returned.

-~ 0 90 T

S @

9. From the Search operation list (10), select the logical construct which is used to combine several elements of the key
phrase, that correspond to the comments to the events to be searched in external databases:
a. AND - to search for comments that contain all the elements of the key phrase;
b. OR-to search for comments that contain at least one element of the key phrase.

10. In the Comment from external DB field (11), enter a key phrase consisting of one or more elements, separated by
commas, that correspond to the comments to the events to be searched in external databases that are specified in the
External DB group (2) (see Creating the Active tracking database).

11. From the Speeding list (12) select the required speeding filter and then in the activated field(s) (13) enter the threshold
value(s) of speeding in km/h.

Note.
This setting is enabled if the checkbox Speeding is set in the Alarm type group (9).

Note.

The value of speeding is calculated as a difference between the fixed vehicle speed and the speed, permitted on
the controlled area of the road.

The following filters of the speeding are available:

6.1 No matter - events of the vehicle, moving with any overspeeding or with the absence of it will be returned.

6.2 More - events of the vehicle, moving with overspeeding, exceeding the entered threshold value will be returned.

6.3 Less - events of the vehicle, moving with overspeeding, less than the entered threshold value will be returned.

6.4 Interval - events of the vehicle, moving with overspeeding, in the entered range of threshold values, will be returned.
12. From the Red light shows at, sec list (14) select the required filter for red light start and then in the activated field(s) (15)

enter the threshold value(s) in seconds.

Note
This setting is enabled if the checkbox Red light violation is set in the Alarm type group (9).

The following filters of the running a red light are available:
6.1 No matter - events of the vehicle, which violated a red light, will be returned.
6.2 More - events of the vehicle, which violated a red light after the entered threshold value will be returned.
6.3 Less - events of the vehicle, which violated a red light before the entered threshold value will be returned.
6.4 Interval - events of the vehicle, which violated a red light within the entered range of threshold values, will be
returned.
13. Inthe Alarm initiated by field (16) select the required operators who initiated the alarm. The corresponding alarms will
be shown in the search results.

Note

This setting is enabled if the checkbox Alarm is set by operator is set in the Alarm type group (9).

Creating the search query by alarms is completed.
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After creating the search query, launch its processing (see section Query launching).

3.3.12.4 Query launching

After forming the search query by vehicles or by alarms, launch its processing by clickingthe Find button (1).

ﬂ Event search in the Recognizers DBEs EI

File View Settings Servers  Internal SVDBs 2

Search by vehicles | Seanch by alams

Vehicle's license plate:
Search operation:  [AND = S

Search results.

| »

Regional Recognizer

License plate Frame Number Plate region A s

License plate not recognized
[ Partly recognized

m

Plate region:
[ <not specified:

LPR channel 1

LPR channel 1

Regional code:
[ <not specified:

LPR channel 1
LP colors:
[ <not specified:> LPR channel 1
B447EpR|19 B447EP190 LPR channel 1
Date/Time '
from: | [ 20118-08-30 17:44:48 @ -
= \L < | T Gl
| Reet |3 [ Fnd 2 fom | 84

As a result search results table will open (2).

Note.

To clear the tabs Search by vehicles, Search by alarms from the entered search criteria, cleck the Reset button (3).

3.3.12.5 Viewing, printing and exporting the search results

Columns of Search results table (1) are displayed in accordance with the settings, given in the Selection of displayed fields
dialog window (see Configuring the events search).

Description of the columns content is given in the same section of the Guide.
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9 ! Search results.

License plate Frame Mumber Plate region E:g;onal E{:ri:gnizer Vehicle speec
LPR channel 1 M
LPR channel 1
LPR channel 1
LPR channel 1

B447ep 19 B447EP130 LPR channel 1

\ .« | i [,

2 i [ 50

To navigate in the results table, use the following interface elements:

1. button - go to the first page of the table;
2. button - go to the previous page of the table;
3. field I - go to the required page of the table;

4. field = 1@ - number of pages in the table;

5. button - go to the next page of the table;
6. button - go to the last page of the table.

Note.
To go to the required page, enter its number in the field (2), and then press Enter on the keyboard.

The search results can be printed or exported as a report (see Printing the search results report), as well as the JPG file (see
Exporting the search results to JPG files).

3.3.12.5.1 Printing the search results report

The event search results can be printed as a report. To do this, follow these steps:
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1. Inthe main menu of the Event search in the Recognizers DBs window, click File - Print.

Wiew

Export...

Exit

Settings

Sensers

24 Event search in the Recognizers DBs

Internal SVDEBs

2. As aresult the search results report preview program will launch in the Plates' protocol - Preview report window.

.é Plates' protocol - Preview report = M
File View Mavigate Document Help
SMHNBH:EDaaa& TR ws - IQEIT 14810 |
=
=
: 1
Plates' protoco .
05 gekabpa 2019
Recognizer Number Country Direction  Recognition ime  License Plates Speed Category  License plate Image Synchronous camera
oE
8-22-2805 The 1S:43:1%
53 kv
LPRchsnnel1  M763KO163 RUS To camers Splins In763Kka 83 |
56 kmin
2013-12-05 =1 |
LPR channel 1 KETIVK163 RUS To camera x5 98 [ x673vx 153
44 kmih
LPR channel 1 V500YHE3 RUS To camers St _
T 15:42:0
70 kmih A
i
s e za = 2018-12-05 ] =
4 »
Pagelof2 - Zoom147%

3. Perform the necessary operations with a report. All operations in this window are similar to those described on the
page Printing and exporting the vehicle data.
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4. If there are more than 1000 entries in the search results the following message will be displayed before the preview report
program launch.

Print £3

-

i "_"'.I Mumber of print jobs - 1436,
Y It is recommended to change search criteria
(e.g., shorten the data receive pericd or enable extra filters),

otherwise, printing can take long time or lead to lack of resources,
Continue printing?

ves | [ No

Note

If the search results contain more than 1000 entries, the report may not be generated, because Windows does
not allocate more than 2 GB of memory to the x86-bit processes.

Click Yes to continue. Click No to come back to change the search criteria.

Printing the event search results report is complete.

3.3.12.5.2 Exporting the search results to JPG files
The events search results can be exported to JPG files. For each event, the following objects will be created:

+ a JPG file containing the frame from the main camera;

+ a JPG file containing the frame from the synchronous camera with the *_secondary.jpg name (if the synchronous camera
is configured);

« an archive containing meta data in the Arena module format (if Debug4 mode is enabled). This functionality is required for
integration with the TRIS.

To export the events search results to JPG files, do the following:

1. Inthe main menu of the Event search in the Recognizers DBs window, click File - Export.

ﬂ Event search in the Recognizers DEs

File | View Settings Servers Internal SVDEs
Print rch by alams
:
Exat AND =
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2. Inthe opened window select the folder in which the JPG files with search results are to be exported. Click OK.

Browse For Folder

(=]

* | inetpub
| PerfLogs
» 1. Program Files

1) Program Files (x86)

» 1. ProgramData =
. Speeding |

> ) Sun

> Users

> VIDED Y

Make Mew Folder J

[ K ] [ Cancel

3. Asaresult all JPG files with violations corresponding to event search results will be exported to the specified folder.

=1 BoR =
@uv| . v Computer » Local Disk (C) » Speeding » - | Jnyl Search Speeding pe |
Include in library = Share with = Slide show MNew folder (i~ I @&

Organize =

- Favorites
Bl Desktop
& Downloads

v
= Recent Places

- Libraries
3 Docurnents
J"- Music
&= Pictures

E Videos

|=|FVF.22.Uniquecomplex.. 20191007 182809.(2).jpg

g FVF.22.Uniquecomplex..20191007 182809.(2).zip

= FVF.22.Uniquecomplex.. 20191007 182809.(2)_secondary.jpg
= FVF.22.Uniquecomplex..20191007.182809 jpg

E FVF.22.Uniquecomplex..20191007 182809 zip
|=|FVF.22.Uniquecomplex.. 20191007 182809 _secondary jpg
= FVF.22.Uniquecomplex..20191007 182810 jpg

E FVF.22.Uniquecomplex..20191007 182810 zip
[=|FVF.22.Uniquecomplex.. 20191007 182810_secondary jpg
= | FVF.22.Uniquecomplex.. 20191007 182814.(2).jpg

E FVF.22.Uniquecomplex.20191007 182814.(2) zip

Exporting the events search results to JPG files is complete.

3.3.12.6 Previewing and printing the event data

EBFVF.22.Uniquecomplex..20191007.182821.(2).zip

=) FVF.22.Uniquecomplex..20191007 182821 .(2)_secondary.jpg
= | FVF.22.Uniquecomplex..20191007.182821 jpg

E FVF.22.Uniquecomplex..20191007 182821 zip

i=| FVF.22.Uniquecomplex..20181007.182821_secondary jpg
i=| FVF.22.Uniquecomplex..20191007.182839.(2).jpg

g FVF.22.Uniquecomplex..20191007 182839.(2).zip

= FVF.22.Uniquecomplex..20191007 182839.(2)_secondary.jpg
|=| FVF.22.Uniquecomplex..20191007.182838,jpg

g FVF.22.Uniquecomplex..20191007 182839 zip

= FVF.22.Uniquecomplex..20191007 182839 _secondary.jpg

To view the event data, left-click the corresponding string in the search results table. View event dialog window will open in

result.

Using the Auto-Intellect software system - 60




View event

WalLie
529537 7e-045b-4733..
K129HK 153

09.08.2010 9:52:22
Car theft

3

Country
Recognition time
Speed

Validity

Direction
Regional code
Category

Recogiee——— mwbcroa

United Arab Emirates: Abu Dhabi
2016-07-22 10:23:04

0 km/h

62 % 4

Undefined

Comments:

Private

In the View event window, the following event characteristics are displayed:

1. Video frame with a caption which contains the following data (1):

2. Fiel

~ 7@ ~0 Q0 To8 @0 an T

Date and time of receiving the vehicle data;
Vehicle speed;

Vehicle direction;

Speed, permitted on the controlled road area;
ID of speed detector;

Control site;

Name of the camera that captured the vehicle.

(2) with the following data:

Identified LP number;

Image of recognized LP;

LP recognizer name;

Date and time of identifying the LP;

Vehicle speed;

Vehicle direction in relation to the LP recognition camera;
Regional code;

Vehicle category;

Alarm reason;

3. Vehicle data from the external LP database if the identified LP has been found there (3);
4. Comments to the event (4).

Operator's Guide

To print the Report or/and export it to one of the most commonly used formats click the Print button (5). Preview report
program will launch in result. In the window of this program there will be displayed the Vehicle characteristics report.
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o
X

& Vehicle data - Preview report —

Eile  Wiew Mavigate Document Help

SNEGE&KS 6O e F e [OE [

&3 Intellect

Vehicle data
Recognizer Arab channel
Country United Arab Emirates: Abu Dhabi
Recognition time 2016-07-22 10:23:04
Speed 0 km/h
Validity 62 %
Direction Undefined
Regional code
Category Private

Arab channel

2016-07-22 10:23:04

IR T
(0 km/h)

Perform the necessary operations with a report and then quit the program Preview report by following the points of the main

menu File -> Exit or by clicking the button x| (see step 4 in Printing and exporting the vehicle data).

3.3.12.7 Creating the Active tracking database

The Active tracking database is the Auto-Intellect software package database and is filled up by operator via the Vehicle Tracer
module.

Note.

It is impossible to remove and change records via the Vehicle Tracer module except changing the stolen vehicle status.

For total interaction between the Active tracking database and the Vehicle Tracing module the following conditions should be
met:
1. The Active tracking database should be connected to the Auto-Intellect software package as an external plates database.
2. This external database should be used by the Vehicle Tracer module for analyzing the identified plates.

If the following conditions are met, the interaction between the Active tracking database and the Vehicle Tracer module is done
in the following way:

1. The operator adds the vehicle LP to the Active tracking database via the Vehicle Tracer module, and specifies the reason

of its adding.
2. The Vehicle Tracer module compares the passing vehicle LP with the LPs stored in the Active tracking database. If the
correspondence between these LPs is set, the alarm is generated.
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Active tracking option is convenient to be used in the Auto-Intellect distributed system, as it enables the operator at his
workstation to notify the remote workstation operators about the vehicle that is to be captured.

Editing the data about the vehicle in the Active tracking database is done in the following way:

1. Click the External Plates DB in the main menu of the Event search in the Recognizers DBs window.

Event search in the Recognizers DBs
File  VWiew  Settings Servers | Internal SWDBs

Search by vehicles | Search by alams | External Plates DB 1

Vehicle's license plate: i

Search operation: AND - ‘ ‘

2. Asaresult Internal SVDBs dialog window will open.

Internal SVDB - ‘External Plates DB 1' o @ |

Mew report of vehicle found in DB | Al reports of wehicles found in DB

a—

3. Click Enter to add records to the database.
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4. Enter the vehicle LP number in the License plate number field (1).

Internal SVDB - ‘External Plates DB 1' o] & |3

New report of vehicle found in DB | All reports of wehicles found in DB |

Report created on: 04122019 16:37:03 Cperatar:
License plate number: | 1
2 Check the fact of driving 60 = I:nefcnre the report is saved, on all servers
Additional info

f R

6[ Cancel ][ Save ]5

Note

To enter a two-line LP number, use two underscore characters "__" as a line separator, for example:
123ABC__THT777.

5. If the fact of vehicle driving to the vehicle report by all boundaries is to be checked, do the following:
«+ Set the Check the fact of driving checkbox (2).
+ Enter the time period using the up-down buttons and select the measuring unit from the drop-down list (3).

6. Enter the description of reason by which the vehicle report is created in the Additional information field (4).
7. Click Save to save changes (5).

Note.

Click Cancel to cancel changes (6).

Note.

Entered vehicle reports are added to the database with the Active status.
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8. Go to the All reports of vehicles found in DB tab to change the status of vehicle report.

10.

11.

12.
13.
14.
15.

Internal SVDB - ‘External Plates DB 1' o ||

! Mew report of vehicle found in DB | Al reports of wehicles found in DE

LP: Search Edi | Delete |

umber Date and Time Cperatar Comment ive \

» 01.08.2018 18:06:53 [+ L
1 4

Refresh Save

. The list of vehicle reports in database is displayed in the table (1):

+ Inthe Number column, the LPs on the wanted list are displayed.

+ Inthe Date and Time column, the time of adding the vehicle report to the database is displayed.
+ In the Operator column, the operator who added the vehicle report to the database is displayed.
+ Inthe Comment column, the reason by which the vehicle report is created is displayed.

« Inthe Active column, the checkboxes are set for the active vehicle reports.

To search the vehicle in the table, enter the search request in the LP field and click the Search button (3). The records
corresponding to the search request will be highlighted with red in the table.

Note

The data is searched in the following fields: Number, Date and Time, Operator, Comment.

To change the reports status, in the Active column (4) set the checkboxes for those vehicle reports which should be active
and uncheck checkboxes for those reports which should be inactive.

Click Edit to edit the selected vehicle report (5).

Click Delete to remove the selected vehicle report (6).

Click Refresh to refresh the list of vehicle reports (7).

Click Save to save changes (8).

Adding the vehicle data to the External Plates Database is completed.

3.3.12.8 Viewing the video archive by event

Viewing the video archive by event can be initiated in three ways:
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1. Right-click the required event, and in the contextual menu select the Video archive option.

I More Ckrl+D

Yiden archive Chrl+M
Find

I
2. Left-click the required event, and on the keyboard push the Ctrl + M keys combination.
3. Holding the Shift key, double left-click the required event.

As a result, the video archive with videos of the event will open.

Video archive

= JL AN 00 01 03 03 04 05 06 OF 0F 09 10 N 13 13 1 15 16 17 15 19 a0 & 23 a3 a4

|

10:49:42
10:50:02
10:50:22
10:50:49
10:51:16
10:51:36
10:51:56
10:52:16
10:52:36
10:53:07
11:1:59
11:11:12
11:11:41
11:12:01
11:12:16
11:12:31
11

4 p>EHII P

X|

To close the video archive, click the |—

button in the right upper corner of the window.

Viewing the video archive by event is completed.
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4 Description of the Auto-Intellect user interface

4.1 The Traffic Monitor interface object

4.1.1 Table panel of the Current value tab

The following figures show the Table sub-tab of the Current value tab displayed by lane and by direction respectively
(depending on the system setup).

Dispalying by lanes:

Displaying by direction:
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The following table describes the elements of the Table panel.

Field name

Time of registration

Total number of vehicles

Passenger cars

Trucks less than 11 m long

Trucks from 11 to 14 m long

Trucks more than 14 m long

Buses

Registered speed of the vehicle

Vehicle length

Description

The time when the last vehicle passed

Total number of registered vehicles of all types

The number of registered passenger cars

The number of registered trucks less than 11 m long

The number of registered trucks from 11 to 14 m long

The number of registered trucks more than 14 m long

The number of registered buses

The speed of the last registered vehicle, km/h

Total length of the registered vehicle, m
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Field name

Average speed for all vehicles

Average speed for passenger cars

Average speed for trucks

Distance between vehicles

Road load

Number of speed overruns

Moving along the oncoming lane

Number of vehicle stops

Jam

Number of incidents

Description

Average speed for all registered vehicles, km/h

Average speed for passenger car vehicles, km/h

Average speed for registered trucks, km/h

The distance between the last vehicle and the previous one, m

Average road load, %

The number of speeding violations

The number of moving along the oncoming lane events

The number of vehicles stopped in the lane

Traffic jam indicator

Total number of road rules violations for the lane (direction)

4.1.2 Charts panel of the Current value tab

Operator's Guide

The following figured show the Charts panel of the Current value tab displayed by lane and by direction, respectively
(depending on the system setup).

Displaying by lanes:
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Displaying by direction:

Operator's Guide

Description of the Auto-Intellect user interface - 70



Operator's Guide

Current Value ' Statistics Traffic moniter 1)
Table " Charts
‘Trafﬁc Detector 2 =l
Total vehicles registered: | [ 10100 1 Free
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The following table describes the elements of the Charts panel.
Number Description
of element
1 The Traffic Detector name
2 The lane number or direction
3 Total number of vehicles registered for the lane (direction)
4 Indication of a traffic jam in the lane (direction)
5 Chart showing the number of vehicles in the lane (direction)
6 Chart showing the road load of the lane (direction), %
7 Chart showing the statistics for the average speed of different vehicles types

4.1.3 Table panel of the Statistics tab

The following figure shows the Table sub-tab of the Statistics tab.
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d € Saveds. ) 5§
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Tahle ¥, Charts /
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The following table describes the elements of the Table sub-tab.
Number Description
of element
2 Set of elements for selecting the statistic frequency
3 Set of elements for entering the beginning and end dates and times of the traffic statistics period
4 The Refresh button refreshes the displayed statistics.
5 The Save as button exports the displayed statistics to a file
6 Traffic statistics results

4.1.4 Charts panel of the Statistics tab
The following figure shows the Charts panel of the Statistics tab.
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The following table describes the elements of the Charts panel.
Number Description
of elements
1 Set of elements for entering the beginning and end dates and times of the traffic statistics period

2 The Refresh button refreshes the displayed statistics.
3 The Save as button exports the displayed statistics to a file
4 Set of elements for selecting the statistic frequency
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Number Description

of elements

5 The Traffic Detector name

6 The lane number

7 Incident statistics for the lane

8 The road load chart

9 Chart showing the number of vehicles in the lane

4.2 The Vehicle Tracer interface description

4.2.1 The Events monitor

The Events monitor contains the following interface elements.

LPR channel 1

WU2160E

The Events monitor interface description is presented in the table:

Element number Description

1 The passing vehicle LP detector
2 The frame with a passing vehicle and a caption
3 The identified LP number and the LP image
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4.2.2 The Alarm window

The Alarm window contains the following interface elements.

1 Report of vehicle found in DB 6 Ga’mshtﬂtd: ZD
2018-08-29 17-50:37
K673YK163 )
LPR channel 1
To camera
BExtemal Plates DB 1
Mot confimed
Field Value N
a2cS8chbf-55ab-e811-aa18-1c1blida7b3d5
License plate number KE73¥K163
Storage time ri
Active for search Yes
Date time of creation 2908 2018 17-42:08
Comment
eratar
_— il rid =
( L 1 £ 5 53 Follow Approve (irformation sent) | | Disapprove

The Alarm window interface description is presented in the following table.

Number Description

of

elemen

t

1 The signed video frame with moving vehicle

2 Date and time when the alarm event was recorded
3 Vehicle license plate number

4 Data about the tools that recorded the event

Note. The field with the name of the external database is hidden if the the alarm event was triggered manually.
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Number Description

of

elemen

t

5 Current state of the alarm event

There can be the following states of the alarm event:

+ Not confirmed - a new event that has not yet been confirmed.

+ Processing... - an alarm event is confirmed, but the information has not yet been recorded to the database.

« Confirmed - the alarm is confirmed and recorded to the database (you may not notice this state since the
event is deleted from the Alarm window after a successful confirmation).

« Error - the confirmation is not recorded to the database due to the heavy load on the Server. It is necessary to
confirm the event again.

6 Number of unprocessed alarm events

7 Description from the stolen vehicles database

Note. The table with the description from the stolen vehicles database is hidden if the the alarm event was triggered manually.
8 Go to the first alarm event in the list; go to the previous alarm event; go to the next alarm event; go to the last alarm event in the list

9 If the checkbox is set it disappears from all alarm windows in distributed environment when the alarm is confirmed, when the alarm is not
confirmed - only from the current alarm window.
If the checkbox is not set the alarm disappeared only from the current alarm window both when the alarm confirmed or not.

10 Confirm the event alarm status. The alarm is marked as received when click this button. The dialog box with the offer to print the alarm event
card will display.

11 Close the alarm window. The alarm status is not changed when click this button (alarm is not processed). Alarm will disappear from the Alarm
window.

4.2.3 The On-line monitor

The On-line monitor component contains the following interface elements.
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19-Z2-2015 Thu

A164BT50
Parameter Value =
Recognizer LPR channel 1
Country |Russia
Recognition time |20]8—DB—30 13:33:07
Speed |12 km/h
Speed limit |5 km/h
Speeding |7 km/h
Validity |26 % i
Direction [To camera
Reoional code | b

6@ ¥

Trace

10

l A164BT50

LPR channel 1
2018-08-30 13:33:07

I AT721CY97

LPR channel 1 0
2018-08-30 13:32:59

I B447EP190

LPR channel 1 1 3
2018-08-30 13:32:54

[ A588CP50

14% 150\ 16 &= - (18®

Print _ Search A Video archi Filter Comment

The On-line monitor interface description is presented in the following table.

Element number

10

11

12

13

Description

Data about the last passed vehicle or event, selected in the identified vehicles protocol or in the
alarms protocol

Go to the Events tab of the identified vehicles protocol.

In case of the alarm event, go to the Alarms protocol tab.
This tab displays the video frame and the LP of the most recent alarm.

Hide the processed events in the protocols.

Enable/disable the pre-configured filters.

Resume the online update of the displayed vehicle protocol.

Alarm triggering by the operator.

Alarm acceptance.

Go to the list of errors occured in the Vehicle Tracer module.

Displaying the information from the external database.

Data about the identified objects protocol or the alarms protocol (depends on the activated tabs -
Events tab or Alarms protocol tab).

Hide/show the panel with comments and external database.

Comments to the selected event.
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Element number Description

14 Create the report with data about the selected event.

15 Open the window for search in the plates recognizers databases.

16 Go to the video archive of identified vehicles.

17 Go to the filter settings, used in protocols.

18 Comments to the selected event with specified date and time of the comment creation.

4.2.4 The Events search in recognizers databases

The Events search in the recognizers DBs dialog window contains the following interface elements.

e

C.File View Settings Servers  Internal S'V"DB:)'I
@earch by vehicles | Search by alarrn;-:Dz

>

Event search in the Recognizers DBs

Vehicle's license plate:

Search results.

-

Search operation: AND - (6
License plate

License plate not recognized
[7] Partly recognized

m

Plate region:
[ <ot specified=

Regional code:

Frame Number

[E=H (=B ==
1313 reconds found
_ I3
Flate region E:géonal

m

[ <not specified=

LF colors:

[T] <not specified=

Date/Time B447EP 19 B447EP150
N A N i .
Heia % C from 53
4 5 - -;

The Events search in the recognizers DBs interface description is presented in the following table.
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Element number Description

1 The main menu that enables to do the following operations:

1. File command:
a. Printing the events search results;
b. Closing the Events search in the recognizers DBs window.

2. View command:
a. Configuring the display of remote servers and databases;

3. Settings command:
a. Configuring the display of events search results;
b. Connecting the recognizers databases.

4. Servers command:
a. Selecting the databases for searching the events.

5. Internal SVDBs command:
a. Editing the user Active tracking database.

2 Selecting the serch type: by vehicles or by alarms.

3 Forming the search query of the selected search type.
4 Clearing the search form from the given search criteria.
5 Launching the search query processing.

6 Events search results table.

7 Navigation panel of the events search results.

4.2.5 The preview report

The preview report program window contains the following interface elements.
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4 Vehicle data - Preview report ==

File  View Mavigate Document HEID1

— N
Intellect

Vehicle data

Recognizer
Country
Recognition time
Speed

Speed limit
Speeding
Validity
Direction
Cause of alarm
Regional code
Camera

. LPE channel T
18-22-2045 Thu 15: _ 2018-08-29 17:06:34

C407TX190
(24 km/h)

Canera 01

4 L3

Pagel ofl ~ Zoom 85%

The preview report interface description is presented in the following table.

Element number Description

1 Main menu for viewing the reports (operations with a file, operations of previewing and navigating the
report, operation with a report, viewing the information about program).

2 Group of elements for operations with a report file (printing, opening, saving, exporting).
3 Group of elements for operations with a report (displaying, content, search, update, edit).
4 Selecting the scaling mode and the scale of displaying the report.

5 Zooming the report.

6 Selecting the mode of displaying the report (page-by-page, nonstop page-by-page).
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Element number Description

7 Group of elements for navigation in the report.
8 Undo or redo the last action.

9 Field for displaying the formed report.
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